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Setting up a Personal Site in SharePoint

You will need to read the Setup guide for SharePoint for Education before you can start on this one.
Your SharePoint personal site is your online space.

* You can use it as your own private online office space and virtual "assistant’ for storing important
documents, contacts and links.

* It can be used for setting up and planning your own workflow across the year and for your own
calendar and reminders.

* Aswith all SharePoint site collections, you can invite others to selected parts of your personal site.

*  You can also add apps if you choose.

As you use SharePoint, you will become a more confident user and be able to try out some of the more
advanced functions and features. You will find a complete list of these by going to Settings, the wheel-shaped
icon at the top right of the screen next to your name. This guide, like the other SharePoint guides, is just to get
you set up and working.

*  You access your personal site by clicking on your name at the top right of your Office 365 homepage.
* Select About me from the options that appear.

e The screen will look similar to this, although at first there will be no activity on your page:

Search everything v 0 “a maria DeBruyn @ edit your profile

Email MariaDB@nomsindo.co.za
Newsfeed

About me
Blog
Apps
Tasks

R, maria DeBruyn's Activities ® About maria DeBruyn
Mailbox maria DeBruyn Help others get to know you by taking a minute to
gﬁ reply if you see this? write something about yourself.
Nomsindo ZA - :

© Roy Hobson likes this.
February20 Like Reply

38 Anele davids beautiful creature
‘ February20 Like Follow Anele davids

Roy Hobson Isee you!

# EDIT LINKS

February 20  Like Follow Roy Hobson -

Add a reply

b e
o Pl

* You can see some posts that this user has made to Newsfeed (In future connecting with others will be
via Yammer, with Newsfeed being for information about any sites you follow). All these appear as an
activity stream on your personal page. Updates to SharePoint sites you start to follow will also appear
here.

e Thisis your own personal SharePoint site. You might use this page to share information about
yourself with colleagues, communicate by message and share your thoughts and writings on a blog
with that same group of colleagues.

* There are several useful functions that you can use on your personal site. You can invite other users to
view some of your features, including your blog and tasks.
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* Explore the commands on the left toolbar. The first one is your Newsfeed. This is your
communication and connection tool on your personal site page where you get update notices
about other SharePoint sites you are following.

* Newsfeed keeps you in touch with what else is going on in your institution’s SharePoint sites,
provided you have chosen to follow them.

e Following other users will soon be done through Yammer, which has even more powerful sharing
functions. Yammer is covered in another of these guides.

* Clicking follow (indicated by the arrow in the below screenshot) on the next screen brings up a list of
suggested SharePoint sites to follow from your institution’s Office 365 platform.

] Office 365 Outlook Calendar People Yammer OneDrive Sites ... Admin ~ [ERNEHENN:ITONEFCRNE]
Search everything = 0 This page displays updates for sites you're following. To connect with people, use Yammer. Learn more
I'm following
(e Following Everyone Mentions
About me 1
Blog It's pretty quiet in here. Follow more sites to see activity in your newsfeed. —
Apps
Tasks 0
Recent i —— documents
Mailbox
Nomsindo ZA 4
sites
# EDIT LINKS O

Trending #tags

Tagging's been quiet lately. No trending tags right now.

*  The next function on the left menu is About me, which is where you add your personal details. This is
the page you first reach when accessing your personal site. Don't forget to use a nice photo!

] Office 365 Outlook Calendar People Yammer OneDrive Sites ... Admin v EEIEUEIE:ITTIESEEoSrd

.‘a maria DeBruyn @ edit your profile

Email MariaDB@nomsindo.co.za

Search everything v 0O

Newsfeed
About me
Blog
Apps
Tasks
maria DeBruyn's Activities ® About maria DeBruyn

Recent
Help others get to know you by taking a minute to

Mailbox (ﬁ maria DeBruyn write something about yourself,

Nomsindo ZA reply if you see this?
© Roy Hobson likes this.
February20 Like Reply =

3 Anele davids beautiful creature
- February20 Like  Follow Anele davids =

Roy Hobson Isee you!

# EDIT LINKS

February20 Like Follow Roy Hobson -

Add a reply

g8 maria DeBruyn
B.h so - some folks got logged in then?
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Now let's look at the rest of the features in the left menu of your SharePoint personal site in a little more

detail.

1. Setting up a blog

* Blog is where you can construct your own blog site. Using the share command at the top right corner

of the screen, you can share your blog with everyone in your institution’s Office 365 platform or

make it by invitation only.

1] Office 365 Outlook Calendar People Newsfeed SkyDrive Sites ... Admin~ [EUSUSIETERT I S ]

BROWSE  PAGE

Biog

Categories

S Welcome to my blog!
Wednesday, October 23, 2013
Ideas
Opinions This is where I'll be sharing my thoughts on topics that matter to me. Who knows... I might even share
O R pictures, videos and links to other interesting stuff.
If I catch your interest, let me hear from you.
Archives
October by Jaye Richards-Hill at 7:39 PM
OLDER POSTS 0comments | Like Emailalink =«

) SHARE Yy Fouow [0

Search this site v 0

Blog tools
Create a post
Manage posts
Manage comments
Manage categories
Launch blogging app
Change post layout:

Basic El

e The Blog tools menu on the right of the screen allows you to create and manage blog posts, allow

comments from other users and categorise your posts.

*  You can also add a picture of yourself underneath this menu.

* The menu on the left of the screen gives you further options for categorising the posts on your blog.

* Clicking on the Page command at the top left of the screen brings up a toolbar containing functions

that will help you when writing blog posts. It should look like this:

1] Office 365 Outlook Calendar People Newsfeed SkyDrive Sites ... Admin~ [ EULTCITERTIINE SN ]

BROWSE  PAGE

D‘ Versions B D C

Permissions

Edit Page Edit E-maila Alert Approve Reject Workflows Edit Mobile Make  Title Bar Tags &

- Properties Delete Page Link  Me~ Page~ Homepage Properties Notes
Edit Manage Share & Track Approval Workflow Page Actions Tags and Notes
Categories

e Welcome to my blog!
Wednesday, October 23, 2013
Ideas
Opinions This is where I'll be sharing my thoughts on topics that matter to me. Who knows... I might even share
AR pictures, videos and links to other interesting stuff.
If I catch your interest, let me hear from you.
Archives
October by Jaye Richards-Hill at 7:39 PM
OLDER POSTS 0 comments | Like Emailalink =+

) SHARE Yy Fouow [0

Blog tools
Create a post
Manage posts
Manage comments
Manage categories
Launch blogging app
Change post layout:

Basic =]
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* Take some time to explore the different commands and options for your blog. You will gradually
become more familiar and confident, and later use more of the different functions. Writing blog posts
is a great way to share your thoughts and views so remember to let others know when you publish a
blog post by posting an update and a link to your post on Yammer.

*  Now go back to your personal site home page. You can do this by using the back arrow on your
device or by selecting About me from the drop-down menu under your name.

*  You will see four other functions on the menu down the left of your screen - Apps, Tasks, Recent and
Edit Links.

2. Working with Apps
*  Your personal site lets you add apps just like every other SharePoint site. This is a good place to
become familiar with apps and practise using their features. You can always delete them if you don't
want to keep them, but take some time to explore all of the many different apps and their functions
and features.
* Click on Apps. This brings up a screen where you can browse and select the apps you would like on
your personal page. The screen will look like this:
) Office 365 Ouook  Calendar People Newsfeed SyDrive Sites -.. Admin~ [N ESSEETNEC

Search everything v 0 \

Site Contents

Lists, Libraries, and other Apps & SITE WORKFLOWS ~ £¥ SETTINGS [ RECYCLE BIN (0)

Jaye Richards-Hill
Documents Form Templates
1item 0items
add an app i Modified 5 weeks ago i Modified 2 days ago

Jaye Richards-Hill MicroFeed Social

Documents 2items 6 items

0 items Modified 4 days ago Modified 4 days ago
Modified 4 days ago

Newsfeed

About me
Blog
Apps
Tasks
Recent
Jaye Richards-Hill

Documents
Style Library

0 items

# EDIT LINKS Modified 5 weeks ago

*  You can find out more about the apps by hovering over each app icon and clicking on the three small
dots that appear on the top right of the app window. For example, if you try hovering over the

Documents app it will look like this:
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] Office 365

Jaye Richards-Hill

Newsfeed
About me
Blog
Apps
Tasks

Recent

Jaye Richards-Hill

Documents

# EDIT LINKS

Outlook Calendar People Newsfeed SkyDrive Sites ... Admin~ Jaye Richards-Hillv £ 2
{=h

St C t t Search everything - ,0‘
Lists, Libraries, and other Apps @ SITE WORKFLOWS ¥ SETTINGS  [&] RECYCLE BIN (0)

Documents Form Templates

Litem — < R
el anaTe Nl Modified 5 weeks ago Click for more information. Jified 2 days ago
® =
Jaye Richards-Hill MicroFeed Social
Documents 2items 6 items
Q0 items Modified 4 days ago Modified 4 days ago
. Modified 4 days ago
Style Library
0 items
i Modified 5 weeks ago

Clicking on the dots reveals an information box that explains a little more about the app. Don't worry
if you dont understand what some of the apps are for. You will become more familiar with them after
using Office 365 for a while. Other guides will explain how to use particular apps in more detail.

When you select an app, it will appear in the menu on the left of your screen under the photo box. You
can see Documents has been added in the above screenshot. Opening this app will enable you to store

documents here.

3. Tasks

This is an area where you can make your 'to do’ list and track your progress.

You can add a new task to this page by clicking on the +add new task command and following the
instructions on your screen.

There are three screen view options listed under the My Tasks heading - Important and Upcoming,
Active and Completed. Clicking on any of these reveals a timeline.

The tasks are displayed on this simple timeline at the top of the page. It looks like this:

B® Microsoft
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] Office 365 Outlook Calendar People Newsfeed SkyDrive Sites ... Admin~ maria DeBruyn~ £ 2
BROWSE  PAGE  TASKS | TIMELINE b
== M -l— k Search everything v 0
Important and Upcoming ~ Active  Completed === Find a task bed

maria DeBruyn @
Novembgr 04

October 31
Newsfeed | |

November 08 November 12 November 16 November 20 November 24

About me

Blog
Staff appraisals

Apps 11/6

Tasks

Important

Recent

i

Mailbox

# EDIT LINKS

Mark active tasks as
' important
or click to add tasks

Upcoming

8 [ staff appraisals =+ 8 Tomorrow

Lost uplated at 1/5/2013 525 AM
e

* At the top left of the screen you will see the three commands Browse, Page and Tasks. Clicking on
each of these will reveal a toolbar with further options for your tasks page.

*  Open these toolbars and have a look at some of the things you can do. Hover your cursor over each
icon to reveal a short explanation of its functions.

e Itis possible to sync your tasks in Outlook (the mail and communications part of Office 365) so that
you can make changes to this part of your site on other devices (including your cell phone), and these

changes will also appear on your main computer.

Using Tasks is a very good way to plan your workflow for the coming academic session. It enables you to see at
a glance how your work is spread out on the timeline. It is also a useful tool for students to use to plan their

work and revision at exam time.
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4. Recent

e Thisis the area that shows recent additions to your site. It is a useful reminder of the latest apps you
have downloaded to your site.

e Itis particularly useful if an app you have selected takes some time to be created. When the app is
completed you will see it appear in your recent list.

5. Edit Links

* Thisis where you can add new weblinks or edit existing ones. You could also add a Links app to
collect all of your links.

* You can also drag and drop links into this space.

*  Your new links will be displayed above the Edit Links command.

As you become more confident in using SharePoint, you will discover more advanced functions that further
enhance your personal site, such as the Mailbox app. This lets you set up a separate email address using
Exchange for a specific project. Email involving this project can be collected in the mailbox and viewed by
project team members, and forms a complete communications record. The people in the team simply include
this mailbox address among the recipients on any mail concerning the project.

You might also wish to set up your own personal Calendar, which you can share with others if necessary.

This guide has just given you a brief tour of some of the basic functions. Log into your institution’s Office 365
platform and try setting up your own SharePoint personal site using this guide as a reference.
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User Scenario — Setting up a student site
in SharePoint

Maria de Bruyn is a deputy head teacher at Nomsindo High School. As she is head of pastoral care at the
school, the Office 365 working group have asked her to set up and moderate a Student Information and
Discussion site on SharePoint. There are several types of SharePoint sites to choose from, including Team and

Community sites.

The site will be for student-led discussions, to provide information such as school policies and rules, and to
make communication between the school and the students much easier. Mrs de Bruyn feels that a community-

style site will best suit these needs.

She logs into the school Office 365 site. She goes to the Admin menu and clicks on SharePoint. In the site
collections list, she sees that a student site has already been set up. There are examples of each the different
SharePoint site types already created here, including Team and Community sites. She could set up other
community-type sites for parents or staff by clicking on the New Site command on the tool ribbon at the top

of the page and then selecting Community from the site type options that appear.

She clicks on the student site link, and then on the URL in the pop up window that appears. The student site
then loads.

e Ontheright side of the homepage, she sees a box named Community Tools. This contains links to a
number of functions.

* These tools allow Mrs de Bruyn to manage the discussion posts and to create reward badges that she
hopes will encourage students to contribute appropriately to the discussions.

* She works through these tools. Manage discussions and Create Categories help the administrator to
organise the discussions and create different categories of discussion or subject threads.

*  She considers making the school prefects administrators of the site to help with this task.

* Shethen clicks on Create badges. This is where students can be awarded achievement badges as
an incentive to contribute. She sees that there are only two achievement levels (Expert and
Professional) and so she decides to create some more.

e Mrsde Bruyn clicks on the + new item and goes through the step-by-step process of creating a
beginner and intermediate achievement badge. These appear in the list on her Badges page. She
will award these badges to students who contribute regularly to the site. Her screen looks like this:
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1] Office 365

Outlook Calendar People Newsfeed SkyDrive Sites ... Admin~ maria DeBruyn~  $x 2

BROWSE | NEMS  LIST ) SHARE Yy Follow [0

> Search this site )
E Badges o

Home
Categories
Members
About

Site Contents

1

@ new item or edit this list
All tems ==«

v Badge Name
Professional
Intermediate %

Expert

Beginner 3¢

Mrs de Bruyn returns to her home page by clicking Home in the left menu.

There are two links in the Community tools menu on the right that she has not looked at yet. Assign
badges to members lets her award badges to the students based upon their contributions to the site.
The Reputation settings link allows her to set the levels at which the students gain achievement
points that can count toward their badges. She works her way through the information, changing
settings where she thinks necessary. She is considering how many achievement points or which levels
should merit the award of an achievement badge. Once she has finished, she clicks OK.

She will need to delegate this job to her school prefects or student representatives.

She now decides to post a welcome message to her students and clicks on + new discussion.

She enters her message title and text into the boxes that appear and clicks Save. She is taken back to
the home page where she sees her new message.

Mrs de Bruyn now clicks on Site Contents from the left side menu.

She wants to add a Calendar to the student page, and so clicks on add an app and searches for the
Calendar app from the choices that appear. She finds the calendar app and clicks on it. After giving it
a name, she clicks Create and is taken back to her home page where she sees the Calendar app in the
left side menu.

She decides to go back to the list of apps and have another look at what is available. After browsing,
she decides to add the Picture Gallery and Announcements apps to her student site.

After doing this, she returns to her site home page. It looks like this:
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] Office 365 Outlook Calendar People Newsfeed SkyDrive Sites ... Admin~ maria DeBruyn~ £ 2

BROWSE  PAGE

) SHARE Y FOLLOW ¢ EDIT i)

Search this site v 0
School Students

o] ¢

Home Welcome to the community. We want to hear from you. Ask a question. Share your thoughts. Get smarter and help others. .
Community tools
Categories . .
@ new discussion Manage discussions
Members -
Recent Whatshot My discussions = 2 Create categories
About Create badges
Recent c ‘ Welcome Assign badges to members
0 replies Hello everybody and welcometoyour new student site. You can earn badges for posting and co...
Student Pictures 0 likes Reputation settings

By maria DeBruyn | In General | 10 minutes ago

Review reported posts
Student Announcement

Community settings

Student Calendar

Site Contents

Join this community

What's happening

1

member

1

discussion

0

replies

Top contributors |
=

*  Mrsde Bruyn is now ready to invite the school students to start using their new site. She clicks on the
Share tab on the top right of her screen and works her way through the steps for adding users.
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* Her school administrator has already set up user groups for teachers, staff, students, classes etc, so all
Mrs de Bruyn has to do is select the Student Members user group, then choose their permission
level. She sets this to Contribute. Her screen looks like this:

] Office 365

BROWSE  PAGE

School Studer

Home
Categories
Members
About
Recent
Student Pictures

Student Announcement

Welcome to the community. We wa

@ new discussion

Recent What's hot My discus!
Welcome

0 replies Hello everybo
0likes By maria DeBru

Outlook Calendar People Newsfeed SkyDrive Sites ... Admin~

Share 'School Students’

&% Shared with [ Sibusiso Morena, [ Sarah Leslie, [ Ruth Levine, and 2 more

Invite people to ‘Contribute’

School Students Members x

Include a personal message with this invitation (Optional)

maria DeBruyn~ ¥ 2

() SHARE Y FOLLOW ¢ EDIT =N

Search this site v 0

Community tools
Manage discussions
Create categories

Create badges

Assign badges to members
Reputation settings

Review reported posts

Community settings

m

Student Calendar

Site Contents HIDE OPTIONS

[¥] send an email invitation

Join this community

What's happening

Select a group or permission level

School Students Members [Contribute] Izl

Bl - 1

member

1

* She also adds some members individually to the site.

e She then clicks on Share to return to the site home page and has a look at some of the other things she
can do with SharePoint.

*  Mrs de Bruyn thinks that the page would look more welcoming with a picture of the school. She clicks on
the Edit tab at the top right of the site home page.

* She can make changes to the appearance of the site in this part of SharePoint.

e Atoolbar runs along the top of the screen with editing functions. Mrs de Bruyn sees that she can change
the way the text on the page looks by using different fonts, colours and styles. She chooses a different style
for the header text on the page and then clicks on the Insert tab at the top of the page.

e The changes take effect and her screen now looks like this:

] Office 365

BROWSE PAGE FORMAT TEXT INSERT
Ho# @n & <«

Table  Picture Videoand  Link Upload App Web  Embed
v +  Audio. v File Part Code

Outlook Calendar People Newsfeed SkyDrive Sites ... Admin~v maria DeBruynv £x 2

) SHARE Yy FOLLOW @ SAVE O

Part
Tables Media Links Parts Embed

Home ; ;

Welcome to the community. We want to hear from you. Ask a question. Share your ool
Categories 0o0ls

thoughts. Get smarter and help others.
Members .

. . - Community tools
OoT Discussions List
Manage discussions

Recent

Student Pictures
Student Announcement
Student Calendar

Site Contents

13

® new discussion

Recent What's hot My discussions &
. Welcome
0O replies Hello everybody and welcometoyour new student site. You can earn badges for posting an...

0 likes By maria DeBruyn | In General | Vesterday at4:29 PM

Create categones
Create badges
Assign badges to members

Reputation settings
Review reported posts
Community settings

Join
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* The new toolbar gives her the options to upload a table, video or audio material, links and pictures.
She selects Picture and is given options for selecting the source of her picture. She has an image of the
school on her computer and so clicks on this option.

* Shelocates herimage and clicks OK. The image now loads to her page. She can change the size by
using the functions in the image toolbar and decides to reduce the size of her image.

* If she selects different parts of her page by clicking on them, new toolbar functions and tabs appear
to help her change things around. Her screen now looks like this:

BAOWSE  PAGE | PomMATTLT | pesear || T wr | wis ran < e 3y rouow g ©
g - ~ . . £ - <>, B
(8] oy I8 = EEMY amaod A-BL AaBbCE [A1BCeD sant
b CheckOut | ¥ Suno. * T W aA- P Pangugh | twaengl |Modegl|| resand | Haangs | tef o cBee
tan et Pont Parsprioh Martue

to Welcome to the School community site. We Tools

MemDe .: S
want to hear from you. Ask a question. Share Community tools

your thoughts and help others.
S0 Priures

Conent Discussions List

new discussion

®

Recen  WhSt'shot My Ssoussions  se» o
oi
. Welcome Join
0rep Hele Y00ty And welconetayour new Tudert e You (an eam hadges 10 pasing an For wsers who are already comerunty member
0lke By mana Defruyyn General  Yetesday 2t 129 PV this wed gart wil rot aooear on ™ page

What's happening
What's happenirg

* Once she is happy with the changes, she clicks on Save at the top right side of her page. This returns
her to the site home page.

*  Knowing her students as she does, Mrs de Bruyn is sure they will have plenty of suggestions on how to
improve the site by adding more features and making further changes.

*  She now posts an update on the site Newsfeed reminding students to follow the site for all news items
and changes.
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User Scenario — Using SharePoint and
Office 365 for class projects and
returning/marking assignments

Office 365 and SharePoint have some great features for class project sites that allow teachers and students
to share resources and assignment deadlines, set tasks, maintain common calendars and enable the
submission, grading and return of assignments. This scenario shows a very simple way in which one teacher
might use SharePoint for a class project site and how one of his students uses mobile apps and OneDrive*

to help with her assignment work.

*Formerly known as SkyDrive Pro.

Sibusiso Morena is a science teacher who has just received his Office 365 login details. After logging in for the
first time and changing his password, he is keen to try and put some of his training into action. He decides to
set up a team site for his Grade Nine chemistry class term project.

* Heclicks on Sites on the top right of his screen. This brings up his home page, which looks like this:

1] Office 365 Outlook Calendar People Newsfeed SkyDrive Sites ... Adminv [ESUSECEVIIIERINE o B4
® new site Search everything )
-\ )
Y Manage the promoted sites below
Followed Sites E> E>
Team Site Public site
Sites I'm following Suggested sites to follow o

You haven't followed any

Sites yet. To see something in Comp\etT ‘/OUC: profile :?d follow
this list, go to a Site and click peopleiand contentioiget
the Follow icon. suggestions here.
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1] Office 365

His Sites view is pretty bare!

Clicking on the OneDrive tab at the top of the screen gives him access to the Office Online versions
of his Office productivity tools (Word Online, PowerPoint Online, Excel Online and OneNote
Online) and his own private resource storage area.

He also recognises Outlook and Calendar as his email and task scheduling tools, and Newsfeed as his
personal homepage where all his messages and changes to documents and other SharePoint sites
that he is following appear in an activity stream.

His institution has not set a specific hierarchy for sites, so Sibusiso decides not to make his Chemistry
project site a subsite of any other site collection. All staff members in his institution have
administrator permissions so he is able to do this. (Note that you need to be an admin in order to set
up new sites, but not subsites.)

Sibusiso looks at the two suggestions for SharePoint sites but decides to click on +New Site to build
his Grade 9 Chemistry site collection. He clicks on the link and the new site template loads on his
screen. He gives his new project site a name and clicks Create. His site is then created by SharePoint

and his screen looks like this...

Outlook Calendar People Newsfeed SkyDrive Sites ... Admin~ Sibusiso Morena~ ¥ 2

BROWSE  PAGE ) SHARE Yy Fouow Cgswc » eom O

Home # EDITLINKS [ search this site )
Grade 9 Chemistry term project

Get started with your site  remove s

&

Share your site.

Home
Notebook
Documents

Site Contents

# EDIT LINKS

16

&)

alla
lv|

Add lists, libraries,
and other apps.

Working on a
deadline?

What's your style? Your site. Your brand. [l Keep email in context

Newsfeed Documents
Start a conversation @ new document or drag files here
v [0 Name
It's pretty quiet here. Invite more people to the site, or start a conversation. T a0 dle e s e

The blue boxes contain suggestions for the contents. Sibusiso works though them for ideas on how to
construct his site.

By following the instructions after clicking on the blue boxes, he adds a logo and changes the
appearance of his site by using a different design template.
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* Next, he adds some apps that he and his students will use during their project. He adds a calendar, a

document store for student assignment submissions, and a tasks planner. His site now looks like this:

] Office 365 Outlook Calendar People Newsfeed SkyDrive Sites ..
BR SE PAGE
A Home # EDIT LINKS Search this site v 0 M
il . Grade 9 Chemistry term project
Home Project Summary

Notebook

+ ADD TASK # EDIT LIST
Documents .
Assignment

Recent 11 PM 12AM

1
Assignment Deadlines |
due
Student Project Tasks
Student Assignments 282 days Assignment 1
Site Contents ago =

m

# EDIT LINKS

Get started with your site  remove s

Working on a
Share your site. deadline?

Add lists, libraries,

and other apps. What's your style? Your site. Your brand. Keep email in context.

*  Sibusiso now adds his students to the team site so that they can use all of the functions and tools. He
knows that when they follow the site they will be able to see the tasks and calendar entries and he
will be able to send messages to their Newsfeeds.

e Heclicks in the Share your site box and searches for his grade 9 students, adding them as he works his
way through his class list. Typing just a few letters from their names brings up their details.

*  Once he has all the names in the box, he checks through his list and adds them to his site, as well as
typing a personal email message to each of them to let them know they have been invited to the
Chemistry project site.

* He then clicks on Remove this above the suggestion boxes so that they disappear.

* Sibusiso types a welcome message into the Newsfeed box, which also sets his students a task. In
addition, he knows his message will now appear in their Outlook email box when they next log
into Office 365.

* The site homepage now looks like this:

] Office 365 Outlook Calendar People Newsfeed SkyDrive —Sites +e.

BROWSE

Home # EDIT LINKS Search this site v 0
il . Grade 9 Chemistry term project
Home Project Summary
Notebook
+ ADD TASK ' EDIT LIST
Documents o
Assignment
Recent 11 PM 12 AM
1
Assignment Deadlines |
due
Student Project Tasks
Student Assignments 282 days Assignment 1
Site Contents ago o
# EDIT LINKS
Newsfeed Documents
@ new document or drag files here
v [ Name
There are no documents in this view.
Sibusiso Morena X

Welcome to the Chemistry project site. For your first assignment upload a document
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* He will use the Student Assignment Document Store to grade the completed assignments and give
feedback to his students on how they could improve their work.

* Sibusiso sets other assignment and task details in the Deadlines and Tasks apps he has placed in the
site. These appear in the menu on the left of the page.

* Meanwhile Jayne, one of the Grade 9 Chemistry students, is browsing on her tablet while s on the train
going home after school and notices an email in her Outlook Web App mailbox.

iPad = 3 19:12 7 £ 63% @)
& ﬁ a outlook.office365.com (& [ o +
Remembrance Day - Wikipedia, the free encyclopedia Jaye - Outlook Web App
OWA for iPad
x Microsoft Corporation View
FREE — On the App Store
INBOX 8
@ all unread to me flaggec Sibusiso Morena has invited you to @

‘Grade 9 Chemistry Project 2014’
» Sibusiso Morena

Sibusiso Morena has invited you t 16:58 s . . .
Hey - join my site! Go to Grade 9 Chemi Sibusiso Morena <Morena@NomsindoED.onmicroso

Sun 10/11/2013 16:58

2 recipients @

To: Jaye
Cc: Sibusiso Morena;

Hey - join my site!

Go to Grade 9 Chemistry Project 2014

Follow this site to get updates in your newsfeed.

= & & .|

e She reads the message from her Chemistry teacher, Mr Morena, and clicks on the link to the project
site which she starts to follow. She notices that there is an assignment to complete by the end of the

week.

l]OfﬂceBGS Outlook Calendar People Newsfeed SkyDrive Sites «.. Admin ~

ﬁﬂﬂ Grade 9 Chemistry Project 2014 '

Home Newsfeed Documents
Notebook .
Start a conversation @ new document or drag files here
Documents | |
Recent

T Follow 'Grade 9 Chemistry Project 2014' X W nts In this view.

Assignment Deadliness When you follow this site, you'll get updates in your newsfeed.
Student Assignments
Follow Cancel
Site Contents

# EDIT LINKS

SHOW MORE POSTS
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* She goes to the OneDrive tab at the top of her Office 365 screen and clicks on it. She then clicks on
the File tab at the top of the screen:

iPad = 19:38 7} 59% @)
< [Tj & nomsindoed-my.sharepoint.com c [ ) |
Jaye - Outlook Web App SkyDrive Pro
1] Office 365 Outlook Calendar People Newsfeed SkyDrive Sites «.. Admin « Jaye Y
————— o .
BROWSE ‘ FILES ‘ LIBRARY Lgsyne 0O
]
New Upload New Edit View Edit Share Alert Download a Workflows Publish Tags &
Document , Document Folder Document Properties Properties Me . Copy Notes
New Open & Check Out Manage ____Share & Track 1 Copies 1 Workflows _Tags and Notes

Welcome to SkyDrive @ NomsindoED, the place to store, sync, and share your work. Documents are private until shared.
Learn more here. Dismiss

new document or drag files here
. :
All - eee 0

Find a file
My Documents .
v [ nName Modified Sharing Modified By
Followed Documents
Shared with Everyone ... September20 2% Jaye
Shared with Me
g5 My staff survey ... 4days ago S Jaye

Recent Documents

We couldn't find any recently
used documents for you

*  She clicks on New Document on this toolbar and types in a name when prompted (Chemistry
Assignment — Jayne). This opens up a blank document in the Word Web App.

* Jayne types up her assignment which is a brief biography of herself and why she wants to study
Chemistry.

e Her train reaches her stop and so she saves the document to OneDrive and closes down her tablet.
She will finish the assignment when she gets home.

*  After she has had something to eat and drink, Jayne sits down with her laptop to do her homework.
She logs into Office 365 and opens OneDrive to recover her document. She finishes working on it
when it has downloaded to her laptop.

e Jayne goes to the Chemistry project site and clicks on Student Assignments from the left menu. She
drags the finished document from the folder on her laptop into the area on the project site screen that
says ‘or drag and drop here’.

* Herassignment is uploaded to the Student Assignment Document Store. She can also share it with
her teacher Mr Morena directly from her OneDrive in Office 365 by selecting Share and typing Mr
Morena’s name into the box on her screen and completing the send email box to notify him.
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e Sibusiso is working at home in Office 365. He checks the Student Assignment document store and

notices that there has been an upload. He opens it and sees that it is from one of his students, Jayne.

] Office 365 Outlook Calendar People Newsfeed SkyDrive Sites ... Admin v

FILE LIBRAR

BF
Home # EDIT LINKS Search this site v 0
ﬂ , Student Assignments
Home @ new document or drag files here
ROTERREE All Documents = Find a file o

Documents
v [ nName Modified Modified By
Recent

B v - Jay «ss 36 minutes ago Jaye Richards-Hill
T @ Chemistry Assignment - Jayne 3 Ie} y

Assignment Deadlines
Student Assignments.

Site Contents

# EDIT LINKS

* Heclicks the tick that appears to the left of Jayne’s document when he hovers over it with his cursor.
This highlights the document title.

* He then clicks Check Out from the toolbar functions that are revealed when he clicks on the Edit tab
at the top of his screen. This stops anyone else from accessing the document while he reviews and
grades it.

*  When he is finished with Jayne's assignment, he selects Check In. In the changes box, he types
assignment graded. Jayne is now able to download her graded assignment and read the feedback.

»  Sibusiso records this assignment activity on the Excel spreadsheet that he uses to keep student
records of achievement for each of his classes. He keeps this spreadsheet in his own OneDrive.

e Jayne uploads the graded assignment to a OneNote workbook she uses as her ePortfolio record of
achievement and for storing notes.

It is often very useful for students to be able to see one another’s graded assignments so that they can learn
from each other and from the teacher feedback each receives.

Alternative and more private ways of returning assignments would be to use sharing with OneDrive, email or
OneNote between teacher and student. The advantage of doing through a class workspace is that all
assignments for the particular subject are managed in one specific place.
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User Scenario - Using a Teacher Team Site
in SharePoint

Thandi has set up her school Art Department subsite in SharePoint and invited all her department staff and
school leadership team to be members. She now starts work on adding resources and apps to her site for her
team to use. She logs into Office 365, clicks on Sites on the menu at the top of the screen and locates the link
to her Art Department site in her list of followed sites. She clicks on this link and her site opens.

e After look around her site Thandi decides to remove the blue suggestion boxes, which she doesn't
need. She clicks on the Edit tab at the right of the top toolbar and the edit page opens up.

*  She clicks on Remove This above the blue boxes. The blue suggestion box Web Part disappears (a
Web Part is just a name for a section or component of a site collections page). Thandi then clicks on
Save at the right of the top toolbar.

* Hersite page loads and the blue suggestion boxes have now gone.

* She types a welcome message for her staff into the Newsfeed box, encouraging them all to type a
message in reply. Thandi hopes that this will become a place for lively discussion!

e Thandi notices that someone has already posted a photograph in the Newsfeed and she sees that it is
one of the school leadership team. Thandi looks to see how this photo was posted.

* She notices a small camera icon underneath the Newsfeed box to the left. Clicking on this brings up
an option to post an image. Thandi uses this to post her own photograph with a comment in the
Newsfeed. The Art Department team site now looks like this::

1] Office 365 Outlook Calendar People Newsfeed SkyDrive Sites ... Adminv [RUEGTGRETENE RPN o B J

BROWSE  PAGE ) SHARE Yy Follow Cgswc o eom

" A
ome Newsfeed Documents

Notebook

Documents

‘ @ new document or drag files here

Site Contents v [0 nName =

Thandi Bongani X
A study in bravery...or sheer stupidity!

There are no documents in this view.
# EDIT LINKS

(T

Afewsecondsago Like Reply

Thandi Bongani X
Hi everybodyand welcome to the Art department sharepoint staff site. Please join in I |

the conversation...

Afewsecondsago Like Reply -

H Jaye Richards-Hill
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e Thandi decides to explore the apps that are available for her site. She goes to the menu running on the
left of her page and clicks on Site Contents.

* She then clicks on add an app, which brings up a choice of available apps for her to select.

* The first app she chooses is a Picture Gallery. She clicks on the app and a text box appears where she
types the name of the new gallery. She decides to use it to feature student artwork and so she names it
Art Department Student work.

e The app now appears in the menu on the left of the page. To add images is a simple job of selecting
files and uploading them, or dragging and dropping. It should evolve into a nice place to showcase
student work to all teachers.

* Thandi then selects the Calendar app. She names it and clicks Create. This new app appears above the
Picture Gallery app in the left menu. Thandi thinks it would be a good idea to use the Calendar app for
important dates and work deadlines during the school year.

e She also adds a Links app. She names the app, clicks Create and it also appears in the left menu. Her
site page now looks like this:

1] Office 365 Outlook Calendar People Newsfeed SkyDrive Sites ... Admin~ [EGEUEIEITIEIENE o]
BROWSE  PAGE ) SHARE Yy Fouow Cgswc » eom [
Teaching Staff Search this site -0 1
Home

Newsfeed Documents
Notebook
Documents Start a conversation @ new document or drag files here
Recent v [ Name
Art Department Web Thandi Bongani There are no documents in this view.
e A study in bravery...or sheer stupidity! =

Art Department
Calendar

Art Department Student
work

Site Contents

# EDIT LINKS

39 minutesago  Like Reply

Thandi Bongani
Hi everybodyand welcome to the Art department sharepoint staff site. Please join in

the conversation...
47 minutesago  Like Reply

W Jave Richards-Hill E|

* Thandi adds some important dates to her Calendar app. By using the Events tab at the top left of the
app page, she can set reminders for important events. Her staff can receive updates when events are
added or changed by clicking the follow button at the top right of the Calendar.
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* The Calendar tab allows her to change the appearance and layout of her calendar and has some more
advanced functions that Thandi will learn about as she gains more experience in using SharePoint.
The Calendar app now looks like this:
1 Office 365

Outlook Calendar People Newsfeed SkyDrive Sites ... Admin~ Thandi Bongani~ £ ?

BROWSE | EVENTS | CALENDAR
Q Version History

Event Permissions

New  View  Edit Attach Alert Workflows Approve/Reject Tags &
Event~ Event Event > Delete Event File Me - Notes

) SHARE Yy FoLlow [,

New Manage Actions _ Share & Track Workflows Tags and Notes
4 >
21 € (3) October, 2013
Jan Feb Mar
Apr May o SUNDAY MONDAY TUESDAY WEDNESDAY THURSDAY FRIDAY SATURDAY
Jul Aug Sep 2 30 1 2 3 4 5
Nov Dec
Today is Thursday, October 31,
6 7 8 9 10 11 12
[EE calendars in View
Art Department
Calendar
13 14 15 16 17 18 19
Home
Notebook
Documents
20 21 22 23 24 25 26
Recent 8:00 am - 9:30 am
Art Department Web Grade 11 exam questions
Links
Art Department 27 28 29 30 31 1 2
Calendar

Art Department Student
work

Site Contents

# EDIT LINKS

* Next, she opens the Links app, which she will use as a list of useful websites for her staff. She clicks on
+Add new in the Weblinks app page and fills in the boxes to add a link to a Government Curriculum
Statement. Her screen looks like this:

] Office 365

Outlook Calendar People Newsfeed SkyDrive Sites ... Admin~ [REENETEETTEITRNNE o M4
BROWSE EDIT

E m &D &% cut ;gc

ER Copy

) SHARE Yy Follow [0

Save Cancel Paste Spelling
Commit Clipboard Spelling
Home
URL * Type the Web address: (Click here to test)
Notebook http education.gov.za/LinkClick. ?fileticket=0%2FMwpUF
Documents Type the description:
R Nat Curriculumstatement Grades 10-12
Art Department Web =
Links P ’ Notes Document tobe used in curriculum planning and lesson
evaluations
Art Department
Calendar
Art Department Student
work 4

Site Contents

Save Cancel

# EDIT LINKS
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e Clicking Save adds this link to the list Thandi is building up for her department staff. They can also add
links and calendar items.

* Sheclicks on the Items and List tabs at the top left of the page, which reveals toolbars with functions
for individual links and for the complete library of links. Thandi sees that some of the toolbar options
are self-explanatory and she plans to spend some time exploring these but realises she will need help
with many of the more advanced function options.

* Thandi explores some of the other functions. She sees that she can upload important documents that
she wishes to store on the site for all her staff. She uploads her administrator’s guide to SharePoint to
kick-start the site library.

*  When it appears on her page she clicks on the small dots next to the name, which opens up a sharing
and editing summary and menu. She can also access it from the Documents on the left menu. She
clicks on it and opens up the Documents page.

* She hovers the cursor to the left of the document name and then clicks on the tick that appears. This
allows her to use the functions on the toolbar that appears when she selects the Files tab at the top left
of her page. She can edit and share the document as well as checking it out for editing, which stops
others from also working on it at the same time.

*  The screen looks like this:

1] Office 365 Outlook Calendar People Newsfeed SkyDrive Sites ... Admin~ Thandi Bongani~ £¥ 2
BROWSE | FILES | LIBRARY ) sHARE Yy Fouow C3smc
Check Out E = Version History o) Fom A Em SendTo . Unpublish
0 0 [ = B B, QL G [}g @ 3
£ CheckIn # 3% shared With S ) Manage Copies Approve/Reject
New pload  New Edit View  Edit Share  alert Popularity Follow Download a Workflows Publish Tags &
Document » Document Folder Document ' Discard Check Out  Properties Properties % Delete Document Me.  Trends Copy GoTo Source Cancel Approval Notes
New Open & Check Out Manage Share & Track Copies Workflows Tags and Notes
Home @ new document or drag files here
Notebook All Documents === Find a file e
Documents
v [ Name Modified Modified By
Recent
v s« About an hour ago Thandi Bongani
Art Department Web . @5 INTRODUCTIONTO SHAREPOINT FOR EDUCATION 3¢ g g

Links

Art Department
Calendar

Art Department Student
work

Site Contents

# EDIT LINKS

e Asthe document library grows, Thandi can use the Library toolbar (which appears if she clicks on this
tab at the top of the page) to organise the documents, as well as use some more advanced functions.

e Thandi now returns to her site home page and looks at some more tab and menu functions.

* She opens NoteBook from the left menu and discovers it is Microsoft OneNote, which can be used
for collaborative projects. She plans to start using this later in the year.

*  One of the features of OneNote is the way groups of users can edit documents in real time. Thandi
knows this will be useful for working with colleagues to develop exam paper questions and course

revision notes.
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e Thandi will now email her staff (and post an update in Newsfeed) to let everybody know about the
changes to their team site so that they can follow the new apps and keep up to date with any
future changes.

e Clicking on the Page tab at the top left of the home page brings up an edit and management
toolbar for use with documents, images and other resources within the site.

e Selecting the Edit tab at the top right side of the home page gives Thandi access to tools that can
help her redesign her site pages.

* She decides that she needs some more help before using these advanced functions and makes a note
to include some training on SharePoint in her Professional Development plan for the year, both for
herself and for her staff.
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User Scenario - Using the Survey App
in SharePoint

Cobus van der Graf is a member of the senior leadership team at his college. They have been discussing
possible changes to the timetable including increasing the number of classes each day by shortening the
length of each class, introducing study periods, and other changes to the way the working week is structured.

Cobus is tasked with putting together a detailed staff consultation process so that all of the staff members can
give their opinions and views on the proposed changes. He thinks a good way to do this would be to use
SharePoint in the new Office 365 platform they have just rolled out, as it would encourage his staff to
participate in the consultation as well as giving them some confidence in using SharePoint and maybe some
ideas for using it with their students and classes.

Cobus logs into Office 365, goes to SharePoint from his Admin Dashboard and opens the Teaching Staff

site collection.

Cobus logs into Office 365 and from his Admin Dashboard, he goes to Sites and opens the Teaching Staff

Site (he sees this site in his list when he opens Sites because he is already following it).

* He sees that his staff members are already using SharePoint as there is an Art Department subsite
that has been set up. The link to the site is in the menu on the left side of the screen. Clicking on the
link, Cobus remembers that he has had an email letting him know about this.

* He has a quick look around the Art Staff subsite and then returns to the Teaching Staff site
collections homepage. He clicks on Site Contents on the left side menu. From the contents screen,
he clicks on add an app.

* He can then choose an app to add to site collection he is working in. The screen looks like this:

1] Office 365 Outlook Calendar People Newsfeed SkyDrive Sites ... Admin~v Cobus Van der Graff+ ¥ 2

) SHARE Yy Follow O

a> Teaching Staff # EDIT LINKS
Site Contents » Your Apps
Your Apps Find an app yel
Apps You Can Add
Manage Licenses Noteworthy
Your Requests i
Cg
s
SharePoint Store . V
Document Library Custom List Tasks
Popular built-in app Popular built-in app Popular built-in app
App Details App Details App Details

Apps you can add  Newest Name
(i | Cal =

Document Library Form Library Wiki Page Library Picture Library
App Details App Details App Details App Details

B P E
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* Cobus scrolls down the page, browsing through the available SharePoint apps. He is thinking about
how he might use some of them in the future with his classes and across the institution.

* He spots the Survey app and clicks on the app details text below the app icon. It brings up a
description of the app functions. Cobus decides to use this app for his staff survey.

* He double-clicks on the app and he is then asked to enter a name for his survey. He completes the box
with the name and clicks on create.

*  The new survey app now appears in the drop-down menu on the left of the screen. Cobus clicks on
Home to return to the front page of the site collection.

* Heclicks on the app to open it up and start to enter his survey questions. The screen looks like this:

] Office 365 Outlook Calendar People Newsfeed SkyDrive Sites ... Adminv [ RESTCRVSREITICIN SN o T ]

) SHARE Yy Follow IO

Tea[hmg Staff # EDIT LINKS Search this site v 0
Reorganisation of learning and teaching survey

Home

=i Respond to this Survey  Actions ~ Settings ~ View: Overview ~
Notebook

Documents Survey Name: Reorganisation of learning and teaching survey

Recent Survey Description:

Reorganisation of
learning and teaching
survey Number of Responses: [}

Time Created: 11/13/2013 6:52 PM

Team Tasks
Staff Weblinks

Subsites @ Show a graphical summary of responses

Staff Site - Art @ Show all responses

Site Contents

# EDIT LINKS

e Cobus is now on the main page of his survey app. He explores some of the commands and
functions. The three functions in blue just underneath the survey title are the main ones he will need
to know.

e Clicking on Settings reveals two functions. The first one is Add Questions. This is where Cobus will
construct his staff survey questions. Selecting this option, a New Question page loads onto the screen.
Cobus sees that there are many different types of response formats to questions he might choose to
ask, such as multiple choice, yes/no and extended answer.

* Cobus discovers that adding questions is simply a matter of making choices, following the instructions
and filling in boxes.

* He can even use the branching logic function, which enables his survey to divert respondents to
different subsequent questions depending on their answers.

* Once he has set his question and specified the type and format of the required response, he clicks on
either Next Question or Finish at the bottom right of the screen.
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e Clicking on Settings again, Cobus selects the second option, Survey Settings. The following screen

looks like this:
] Office 365 Outlook Calendar People Newsfeed SkyDrive Sites ... Admin~ Cobus Van der Graffv £ 2
) SHARE Yy Follow IO,
E> Teaching Staff # EDIT LINKS
Reorganisation of learning and teaching survey » Settings
Home List Information
Notebook Name: Reorganisation of learning and teaching survey
5 . Web Address: http: i d.sharepoint.c: /Teachingstaff/Lists/Reorganisation of learning and teaching survey/overview.aspx
ocuments
Description:
Recent
Reorganisation of General Settings Permissions and Management Communications
learning and teaching
survey
o List name, description and navigation @ Delete this survey a RSS settings
Team Tasks 8 Advanced settings @ Save survey as template
Staff Weblinks 8 Audience targeting settings @ Generate file plan report
Subsites 8 Rating settings @ Enterprise Metadata and Keywords Settings =
a Form settings @ Information management policy settings
Staff Site - Art
Site Contents
Questions
7 EDITLINKS A question stores information about each item in the survey. The following questions are currently available in this survey:
Question Type of answer Required Branching Logic
test Multiple lines of text v
Modified Date and Time
Created Date and Time
8 Add 2 muactinn

* Thisis where Cobus can make changes to any of his questions, re-order them and make other changes
to this survey. As he gains more confidence and experience he will try out some of the more advanced
features he sees on this screen.

* Using the Newsfeed on the Teaching Staff site, or by email, he can let all of the staff know about the
new survey. They go to the site, open the app and click on Respond to this Survey.

*  Ashis colleagues complete the survey, the responses start to register on the Survey app page. Cobus
is able to see the responses either individually or displayed on a graph. He can also set up
notifications to let him know when a new response is received.

e Using the drop-down Actions menu, he can export the survey response data from the app into an
Excel spreadsheet, provided that the responses are numerical or quantitative. This would let him
apply more sophisticated forms of data analysis to advanced or complex surveys.

* Excel also has other display and graph/table options for him to use with the exported raw data from
the survey app.

Cobus can think of many uses for surveys in his institution and for learning and teaching including
the following:

e Quizzes and tests for formative assessment (i.e. before and after individual classes)
* Capturing data for statistics problems in Maths classes

* Capturing data for science classes

* Parent/caregiver surveys

* To help gauge opinion about changes to policy and procedure

Surveys are a quick and easy way to consult with staff and students to help education institutions like Cobus'’
college make more informed decisions and better choices.

The Survey app is just one of the many useful apps available for use in SharePoint site collections.
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